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Computas AS’s METIS can be described as a powerful visual modelling tool that 
helps you to address complex enterprise architecture questions and to solve 
business and technology issues as an enterprise architect. METIS is methodology 
neutral, and is flexible enough to support any modelling or architecture approach. 
METIS’s key focus is on representing and visualizing the architecture, and as a 
result, METIS has a powerful model development interface. METIS can also be 
integrated with third party tools through its import/export wizard. As well as the 
METIS modelling engine, Computas AS also ship a browser add-in, the METIS 
Model Browser, which allows the models developed in METIS to be accessed via the 
web. 
 
The version of METIS described in this review was version is 3.2.3.  
METIS is only available for Microsoft Windows (Win95, Win98, WinNT, and 
Win2000). Windows 2000 Professional, SP1 is recommended.  METIS is shipped on 
a CD, and installing METIS is a simple and straightforward process. One of the 
unique features of METIS is that it is based entirely on XML (eXtended Markup 
Language). XML is used to represent the meta-models (called templates in METIS) 
as well as the user-developed models. Rather than having a single repository file, 
METIS includes several directories of XML files containing the descriptions for the 
various objects, relationships and icons (symbols) used by the default METIS meta-
models. 
 
METIS Team Server is the server-based repository for sharing Metis enterprise 
models within a modelling team and publishing them securely on the Internet or your 
intranet. METIS Team Server gives you full model versioning and secures access 
control, greatly simplifying the challenges inherent in the collective modelling effort 
that is always needed in order to ensure that your enterprise models are 
disseminated, updated, accepted and used widely within your organization. 
METIS Team Server is seamlessly integrated with METIS Model Browser, Model 
Annotator, Model Editor and Model Designer, and deploys and scales across 
standard Web server, middleware and database infrastructures. 
 
Almost all the METIS documentation is in electronic format, apart from 2 manuals, 
one is the Getting Started with METIS 3.2 guide; the other one is the Getting Started 
with the METIS Metamodel Developer guide. Computas AS provides most of the 
METIS documentation in Windows Help File Format, and several PDF format 
documents. Overall, the documentation is well written and clear. As well as the 
electronic documentation, METIS is also shipped with an excellent Computer Based 
Training (CBT) tutorial. The tutorial includes about 30 minutes of ‘screen cams’ with 
high quality narrations, as well as summary and review pages. However, the CBT 
tutorial only covers the basic features of METIS and is based on version 3.0. 
 

Supported Methodologies and Business Solutions Templates 
METIS 3.2 GEM - Generic Enterprise Modelling. GEM is an interesting, Zachman-like 
framework for modelling many different elements of an enterprise.  
                                                 
1 Jaap Schekkerman, B.Sc. is the founder of the “Institute For Enterprise Architecture Developments’ and author of 
several articles and books about Enterprise Architecture see also http://www.enterprise-architecture.info. 
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METIS 3.2 ABM – Advanced Business Modelling. The Advanced Business Modelling 
template builds on GEM, extending it with a rich set of modelling elements. ABM 
incorporates modelling elements from ITM 3.1 and other meta-models and supports 
sub-model constructs. 
 
METIS 3.2 ITM – Information Technology Management. The Information Technology 
Management template supports sub-model constructs. ITM is the basis enterprise-
modelling template to be bundled with the Model Editor / Designer / Developer and 
supports sub-modelling. 
 
METIS 3.2 UML – Unified Modelling Language. A template and meta-model for UML 
modelling is available and supports the main UML modelling constructs and 
diagrams and will allow import and export of UML models from other tools. 
 
Computas AS have several other modelling approaches available, including, systems 
engineering, project- management and product management. These additional 
modelling approaches are available from Computas AS at an additional cost. 
 
ITM is METIS main EA- template and is flexible enough to capture the essence of 
Enterprise Architecture. ITM is organized into different domains, with each domain 
containing a collection of objects, relationships and criteria (or search filters) aimed at 
modelling part of the enterprise. The objects contained within the different domains 
can be related to each other, resulting in a detailed, multi-faceted view of an 
enterprise. Computas is working on a C4ISR-template for the US DoD, which is due 
for release spring 2003. 

Model Developers Interface 
METIS’s Model Development Interface is the tool’s most powerful asset. The 
interface is intelligently designed, matures and includes many useful and unique 
features. The layout, as shown by the screen shot below, includes a navigation area, 
called the tool tree by METIS, on the left side of the screen, and a model 
diagramming area, called the editor space by METIS, on the right. 
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METIS makes extensive use of tabs along the bottom of the tree tool, and the editor 
space. The tabs are used to switch between different views of the tree tool and 
different views within the editor space. Along the top of the METIS screen are the 
various contextual tool bars and drop-down menus. 
Overall, the METIS model development interface follows most of Microsoft’s 
Windows 95, 98, 2000 and NT 4.0 GUI conventions. 
 
The tree tool (the left of the METIS screen) functions as the key navigation tool and 
as the tool palette, and icon storage area. The tree tool can be switched between six 
different views, each associated with a specific tab running across the bottom of the 
tree tool. The File Tab displays the computer’s file hierarchy, and is a convenient way 
to find the various data files created by METIS. The Domain Tab is essentially the 
tool palette. It contains the various objects, relationships, methods and criteria made 
available by the meta-model being used. The Object Tab holds a list of all the objects 
available in the currently loaded and previously loaded models. The View Tab 
displays all the objects in the current model view. The Symbol Tab holds the various 
icons and graphics currently loaded. Within this view of the tree tool, existing icons 
and graphics can be modified and new icons and graphics created. The Loaded 
Tab displays and provides access to all elements have been loaded by METIS. This 
will include the objects, relationships, icons, and so on. 
 
The METIS modelling interface is built on the concept of a view. A view is the 
graphical representation of the model. The view may be the complete model, or it 
may be only part of the model. One model can be spread across several views. The 
different views of the model generally can be navigated by the tabs running along the 
bottom of the editor space, shown on the right of the METIS window. As will be 
described later in this evaluation, views can be automatically generated as a result of 
a search function, by importing data into METIS. 
 
Building models in METIS is straightforward. The various modelling objects are 
dragged from the domain view of the tree tool, and dropped into the editor space. 
Objects can be dragged and dropped onto each other to activate the default 
relationships. Other relationships between objects can be dragged from the tree tool 
to the various combinations of objects in the editor space. METIS enforces the rules 
of the meta-model, only allowing legal relationships between objects. 
 
Unlike many tools in this class, the icons used to represent the modelling objects are 
not just simple static icons, but complex interactive elements. Icons within METIS can 
function as containers or as the parent of hierarchically decomposed objects. 
Conceptually, container objects contain other objects. Container objects can be 
visually opened and closed, hiding or exposing the models they contain. The type of 
container objects supported by METIS depends on the modelling approach being 
supported. Sub-processes can be contained within the top-level process object. The 
top-level process object can be opened and closed, hiding or showing its sub 
processes. This is a very powerful, visual way of dealing with the complexity of large 
models. As well as the concept of a container, the METIS modelling interface also 
includes the concept of a hierarchy. As with the concept of a container, a hierarchy 
can be used to hide or show its child elements. Closing a hierarchy object will 
remove its child elements from the view. Opening a hierarchy element will show its 
child elements. 
 
In addition to their graphical representation, each object within METIS also has a 
textual view. The textual view generally holds various additional properties of the 
object, for example, its name, description, and any other text fields relevant to the 
object. The textual view of the object also includes a dynamic list of the various 
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relationships in which the object participates. These links can be navigated, and at 
the end of the links display the text view of the object. 
 
One of the more interesting interface features of METIS Model Development 
Interface is its automatic diagram layout function. The automatic diagram layout 
function will automatically redraw a model diagram, optimizing its layout based on the 
layout strategy used. METIS supports two types of layout strategies; matrix and 
hierarchical, each optimized for particular model layouts. Different strategies can be 
applied to different parts of the same model. Most of the properties of the existing 
layout strategies can be modified, so the layout strategy can be customized for 
particular model types, by the end-user. 
 
The icons (called symbols in METIS) used to represent the modelling objects and 
relationships within METIS can be fully customized. METIS’s icons are Scalable 
Vector Graphics (SVG) format, and METIS includes its own icon editor to create and 
modify icons. Most popular graphical formats including Bit Map (BMP) and JPEG 
(JPG) and Windows Meta-Files (WMF), can be imported into METIS icon editor, and 
used as METIS icons. 
Another powerful, and unique feature of METIS is the ability to have icons, 
representing various modelling objects and relationships, change depending on the 
state, or the value of properties, of the objects they represent. Icons representing 
complex structures, for example containers, or hierarchies, can be visually opened 
and closed, with different icons used to represent the open and closed state of the 
object. 
 
The individual elements that make up icons (the text, graphics, colours, and so on) 
can change their state depending on the values of the underlying object’s properties. 
For example, it is possible for the background of an icon to turn red to show 
incomplete data, and to turn green when the data is complete. 
 
The METIS model development interface also includes the ability to zoom in and out 
of the model. The ability to zoom in and out of a model is a useful, visual way of 
navigating a large and complex model. Within METIS the model can be globally 
zoomed, zoomed to a selection -- so that a selected part of the model is optimally 
sized, zoomed to text -- so that the model is re-sized so the text is readable, and 
zoomed to the primary object - which re-sizes the model so a key object, a container 
or parent of a hierarchy is visible. 
 
In addition to zooming METIS also includes browse and fly through modes for 
viewing a model. The browse mode is a powerful and sophisticated way of navigating 
through a model. Within browse mode, clicking-on any model objects will bring it into 
view. Zooming out of that object will return to the previous view. The mouse can be 
used to move the model within the editor space. The browse mode is ideal for 
navigating or demonstrating large and complex models. Similar to browse mode is fly 
through mode. Fly through mode allows the user to easily pan and zoom in and out 
of the model, allowing quick, seamless navigation within a model. 
 

Who Will Use METIS? 
METIS is a flexible, sophisticated and mature tool, which would be well suited to all 
Business Modellers and Enterprise Architects. Capability developers and operational 
planners would find METIS an idea tool for capturing, representing and manipulating 
complex enterprise architectures. METIS’s Extendibility would mean it is able to 
support any standard or customized architecture approach. METIS’ ability to 
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generate new models based on the powerful search functions would allow the two 
groups to easily manipulate the architecture they develop. 
 

Reporting & Analysis 
However, METIS’ lack of sophisticated architecture analysis and reporting functions 
may limit METIS’ utility for these groups, making it difficult to extract data from 
METIS, or to perform any kind of analysis on the data directly in METIS. 
 

Reporting 
Simple Reporting in METIS can be done in two conceptual steps: the first one is to 
decide what you would like to include in your report and optionally generate a 
separate model view for these objects. The second step is to choose the export 
format (if a METIS model view is not enough). Two possibilities exist in the standard 
package: HTML reports (with text and graphics) and CSV export. 
 
Other export -import options are available in add-on products, including an interface to 
MS Project. Customising exports to e.g. Excel is also relatively simple, but requires 
some knowledge of script programming. 
A new flexible reporting object that allow model developers to embed report definition 
objects in the models and a new generic xml interface for import-export to other tools 
is planned for the next release. 

 
Analysis 
A specific analysis tool is not available/visible in the basic METIS tool, you still have 
the generic search “criteria” mechanism, which you can be combine, as well as define 
yourself. This criteria mechanism gives you the power equivalent to any sql query you 
can think of, not mentioning that you can do all the querying visually which is a 
tremendous advantage when not_so_familiar_with_sql people are trying to make 
sense out of its own EA.  
If the Criteria mechanism is still not good enough, you have the possibility to write a 
piece of program and associate it with a given object type as a method. A method 
might be simple, like changing colours of icons depending on property value, or a bit 
more complicated e.g. computing activity-based cost for a given process based on 
cost of its sub-process, etc.   With methods, your are in a “regular” programming 
environment and can do whatever you need to do. 
 
Metis solution templates typically come with many predefined domain-specific 
analysis capabilities. With the Meta model Developer, user-defined methods and 
criteria can be added to Meta models and templates, making them readily available to 
model users as context-dependent object menu entries in the tool.  

 
For Enterprise Architecture researchers, the METIS expressive meta-modelling 
language, and its complete flexibility would provide an ideal tool for exploring 
architecture concepts and constructs.  

Overall Impression of METIS 
Overall, METIS is a sophisticated, stable and mature product. The model 
development interface is one of the best seen in this class of tool, providing some 
powerful and unique visual tools to capture complex architectures, including the 
ability to open and close objects, as well as the useful zoom, browse and fly through 
methods of viewing architectures. METIS’s meta-modelling approach seems to 
provide full flexibility. However, METIS lacks of any kind of sophisticated architecture 
analysis and tracing tools. While it is possible to export data out of METIS into third-
party analysis tools, this adds an extra level of complexity to analyzing architectures.  
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METIS’ Team Server hierarchical repository structure organizes items in, and 
navigated through, a standard, hierarchical folder structure, which can be free 
organised. The lack of a central repository XML database, and reliance on XML as 
the method for representing models and meta-models may impact on how well 
METIS can scale for very large and highly complex enterprise architectures. 
 

Note 
Additional info from Computas. 
 
The following 4 features make a foundation for an effective and exceptionally flexible 
administration and management of large and complex projects: 
 

A. METIS makes it possible to divide a model into sub models.  
B. Team Server provides the repository functionality (i.e. versioning and state-transition 

labels, access control, check-in and check-out) for any model, in particular sub 
models as well.  

C. Any model in the repository goes through pre-defined, user-configurable state-
transitions (or Life cycle phases if you prefer) e.g. Development, Review, and 
Production.  

D. For models consisting of sub models it is possible to indicate which particular version 
of a sub model is actually referred. So-called dependency rule may use notions like 
last version, version with a given number, or last version with a given state, e.g. last 
version with state=Production. (Notice that this feature makes the fact that the 
repository is organized as a hierarchy irrelevant for designers - any model can be 
“included” as a sub model. Hierarchy is needed only to support proper administration 
of privileges.  

 
Those features make the following possible: 
1. To distribute responsibility for models (modelling and update). Somebody takes care of 
modelling of processes; somebody else takes organization, strategy etc. The user decides 
how to split the model.  
2. To support Life Cycle of the EA model!   It is absolutely possible (and recommended) to 
work in parallel on different aspects of the EA model. 
 
Imagine a situation where we have the following sub models: Organization, Processes, and 
Architecture. One METIS model may capture current EA by including all the sub models with 
dependency rule: “last version with state=production”. But at the same time, a person 
responsible for processes may plan changes to be implemented in 2003. His model also 
includes all 3-sub models but it is possible to indicate that Organization and Architecture must 
be in “Production” state, but Processes in “Development” state. The new changes will not be 
“visible” in the current EA model, until sub model Process goes through review and will be 
accepted as in “Production”.  
 
Some of our customers have to deal with much more complicated cases with multiple 
acceptance of parallel changes to more than one sub model, but even then, the METIS 
function  “Validate model” makes it feasible just to accept changes and then identify and solve 
the possible problems (missing objects, relations pointing at the wrong object etc). 
 
If it sounds complicated, it simply is. Our customers say that METIS (with Team Server) is the 
only system able to support that kind of complication! 
 
Finally, with regard to integration: 
 
?? METIS Database Interface allows the import of data from SQL-databases directly. Rows 

in tables are converted to METIS -objects according to user-defined mappings. 
?? an XML-bridge is slated for release this spring, converting from foreign XML to METIS-

XML 
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?? The COM-interface means METIS can be scripted from VBScript, C#, C++. This 
mechanism allows for easy integration with e.g. Excel and MS Project, as well as any 
other COM-compliant software. 

 
We are confident that METIS integrates well enough for most practical purposes. We also 
believe that the choice of XML for data storage is a good one, though you seem to have some 
misgivings about this. Our experience shows that storing the data directly in relational 
databases gives major performance problems. One great advantage of XML is that it is very 
open, so we don't lock the customers to proprietary solutions. XML-files do get large, but they 
compress very well, and the latest release of Team Server includes compression both for 
transmission and storage. 
 
 


